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Legal notices
Copyright 2023 - 2024 Open Text

The only warranties for products and services of Open Text and its affiliates and licensors (“Open Text”) are as
may be set forth in the express warranty statements accompanying such products and services. Nothing herein
should be construed as constituting an additional warranty. Open Text shall not be liable for technical or editorial
errors or omissions contained herein. The information contained herein is subject to change without notice.

Except as specifically indicated otherwise, this document contains confidential information and a valid license is
required for possession, use or copying. If this work is provided to the U.S. Government, consistent with FAR
12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data
for Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Documentation updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.
l Document Release Date, which changes each time the document is updated.
l Software Release Date, which indicates the release date of this version of the software.

Support
Visit the MySupport portal to access contact information and details about the products, services, and support
that OpenText offers.

This portal also provides customer self-solve capabilities. It gives you a fast and efficient way to access
interactive technical support tools needed to manage your business. As a valued support customer, you can
benefit by using the MySupport portal to:

l View information about all services that Support offers
l Submit and track service requests
l Contact customer support
l Search for knowledge documents of interest
l View software vulnerability alerts
l Enter into discussions with other software customers
l Download software patches
l Manage software licenses, downloads, and support contracts

Many areas of the portal require you to sign in. If you need an account, you can create one when prompted to
sign in.
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Introduction
OpenText™ Database Activity Monitoring (DAM)provides privileged user and application access
monitoring that is independent of native database logging and audit functions. It can function as a
compensating control for privileged user separation-of- duties issues by monitoring administrator
activity.

DAMmonitors database activity without audit subsystem of the respective database server being
turned on. It classifies and correlates the audit logs and store them outside the database to comply
with seperation-of-duties principle. DAM also ensures that a service account only accesses a
database from a defined source, and only runs a narrow group of authorized queries. This can be
used to detect compromises of a service account either from the system that normally uses it, or if the
account credentials show up in a connection from an unexpected system.

DAM Agents can record all SQL transactions (DML, DDL, DCL, and TCL) without relying on local
database logs, thus reducing performance degradation. DAM lets you:

Monitor Logins - Monitor successful and failed logons and ensure they are from predefined and
valid sources.

Monitor Changes - Audit SELECT, UPDATE, DELETE, EXEC, and other SQL statements.

Monitor Access to Sensitive Information - Monitor who is accessing sensitive information. When
the unexpected happens generate alerts.

Monitor Privileged Users - Audit DBA/Developer activity and configuration changes to the
database system.

Generate Reports - Pre-defined policies and reports for PCI, SOX, and other generic compliance
requirements.

Abbreviations

Abbreviations Definition

DAM Database Activity Monitoring

DSIM DAM Installation Manager

DSPL DAM Socket TAP Module

DSTAP DAM TAPModule

LDAP Lightweight Directory Access Protocol

OpenVAS Open Vulnerability Assessment Scanner

SIEM Security Information and Event Management

SMTP Simple Mail Transfer Protocol
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DAM Users and Roles
DAM has flexible user role management support that makes DAM available to create its roles
depending on the privileges defined before. These roles are like groups in DAM. New roles can be
created by admin, and users can be assigned to these roles. For more details, see All Settings.

DAM Architecture
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Logging in to DAM
The user should log in to OpenText™ Database Activity Monitoring application.

1. Double click on OpenText™ Database Activity Monitoring icon.

2. Enter Server Name, Username, and Password on the DAM login page.

3. Click Sign In.

NOTE: The Server Name field can be filled in 3 ways: localhost, Server IP, or Server hostname.

l If logging in through the server, the user writes localhost.

l If accessing the server from user’s environment, the user writes the Server IP or Server
hostname.
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DAM Usage

Menu and Controls
DAM has nine menu items and some control buttons. These are listed in the table below

Menus Function

Home Used to display the home screen of DAM.

Search Used to search events and export search results as xls or pdf.

Alerts Used to view alerts in detail.

Dashboards Used to view and edit dashboards.

Agents Used to show Agents, Policies and Options tabs, and Refresh, New Agent,
Edit, Delete, Actions (Export, Send as E-mail) and Open Terminal tasks.

Alert Rules Used to show alert and correlation rules.

Mappings Used to view, edit and manage mappings in detail.
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Lookup List Used to show Lookup Lists.

Settings Used to reach Settings as Users, User Activities, Roles, API Users etc.

Used to close and open the menu on the left. The menu part can be closed
for a wider graphic view.

Used to turn pop-up contents on or off.

Used to reach user details. Includes Logged On Users,My Profile and
Logout submenus.

Used to show Copyright, Version, Disclaimer and License information

Used to check updates

Used to refresh.

Used to show System Errors (red), Warnings (yellow) and Messages
(green). Details and content can be viewed with the ( ) icon. The

numbers in the colored boxes indicate the number of errors, warnings, and
messages.

Home
Performing an analysis of the current situation using a single screen facilitates efficient work
management by enabling prompt actions to be executed. Accordingly, Home screen presents
Cluster Status, Health and Disk, Index Size, Database Info, Top Activity andOngoing Alerts
analysis to the user.
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Cluster Status

The panel containing information about ElasticSearch provides insights into the status of your
system. The most important feature on this screen is the ability to monitor the performance of the
machine where the SIEM product is currently installed in real-time.

l Nodes shows the number of shards in the database (determined based on the system size).

l Events shows the number of events in the database.

l Data shows the record size.

l Uptime shows the active time period of the system.

l Version shows database version number.

l Node Name shows the node name.

l Server Name shows the server’s name.

l CPU Usage shows the CPU usage percentage.

l Memory Usage shows the memory usage percentage. The max value, is also given with the
Memory Usage, shows the amount of memory allocated for ElasticSearch. In Figure 5, the max
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value for ElasticSearch is given as 3 GBmax.

l Shards shows the number of the small unit where records are stored.

l Heap Size shows the amount of allocated RAM to the Elasticsearch mode.

l EPS shows the events per second.

l Messages in Queue shows the real-time incoming log count.

Health and Disk

This panel shows the information about cluster health and disk capacities.

l Unallocated shows the available unit count.

l Total Shards shows the number of the small unit where records are stored.

l Free Disk shows the remaining free space on the disk.

l Total Capacity shows the total disk capacity.

Index Size

This panel shows how many computers are sending logs, how many computers have DAM agent
installed in Active Directory, and how many computers have not connected to the system for a long
time . Index Size i s the database index, it graphically shows the amount of logs written to the
database. If the log amount is the expected (average) number, the bar is shown green , if it is more
than or lower than expected, the bar is shown red.

Database Info

This panel shows the number of records and the amount of space they occupy in two separate
databases categorized as HOT andWARM. Hot database keeps records for the specified number of
days. In default, the number of days is given as 180 and it keeps records of the last 180 days. Warm
database keeps a record of 180 days before hot database records.
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l Indices shows the number of days for real-time log retention.

l Earliest shows the start date of log collection.

l Events shows the number of events.

l Size shows the total size of the events.

Top Activity

This panel shows the events and network activities based on their importance level, with the ability to
determine the number of top items to display.

Top Activity panel, which operates in sync with INDEX SIZE, potentially provides you with the most
important information. It presents records sorted by the importance level, name, and quantity of the
generated events. Additionally, it also provides information about which machine the respective
events occurred on and how many instances occurred.

Events

l Severity shows the event type.

l Event Name shows the event description.

l Count shows the number of occurrences of the event.

l Machine Name shows the machine name where the event occurred.
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Ongoing Alerts

This panel shows critical events occurring during the day. It also provides alarm rules that have been
predefined or created according to the organization's needs on the monitor screen. Relevant alarms
are color-coded based on the criteria of the events.

When clicked on the relevant alarm, user can view the details of the events that occurred in a new
tab.

l Warning shows the warnings on clients.

l Error shows the unsuccessful attempts on clients.

l Security Issue shows the security breaches and vulnerabilities.

l Information shows the information of actions on clients.

l Success shows the successful actions.

Search
Search panel provides a search engine where user can examine event records in detail.

Search Panel

In this screen, user can run automatically generated queries by the system or create new queries to
capture specific records. Users can select and search for different SearchDB clusters/seeds from
Available Seeds options through a single Search UI.

Accordingly, the Search screen presents Breakdowns, Search Results, Event Details and Field
Chooser to the user.
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Date Range Section

The date range section is automatically set to scan events that occurred within the last 5 minutes.
Additionally, users can click on the relevant section to customize the date range according to their
preferences.

Users can finalize their search by using the mouse to select the preferred time period on the chart.
This empowers individuals to clearly define the precise time span they require. In the date range
section, aside from the regular time intervals, there are choices labeled as Hot DB andWarm DB. Hot
DB pertains to the initial 180 days, while Warm DB relates to the subsequent 180-day period. These
choices enable individuals to conduct searches within both the currently active data and the archived
data, all within the specific time spans they've chosen to search within the active and archived data
for the specified time periods.

Range

Range Panel provides information about the time range for which the report was generated.
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Export and Save Actions

After completing the search, users can save the results as report or query, export them in Excel or
PDF format, or send it via email by using the Save button.

Field Chooser

When you right-click on the unwanted columns in the query report and select "Remove" the
respective column will be removed from the report area.

Field Chooser panel provides two different field structures:
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Standard Fields: It lists the columns that exist in the standard event records and are automatically
displayed in the report screen.

Dynamic Fields: It lists the columns that have been defined based on the user's specific needs,
beyond the standard columns for event records. The button on the right side of the column is used for
hiding unwanted or re-adding desired columns.

Controls Function

Used to hide the Field Chooser panel.

Used to filter the fields.

Used to add the filter to the Breakdowns
list.

Used to add the filter to the search results
table as a column.
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When the user right-clicks on any row in the Search Results table, the user can reach the actions
given below.

l Edit Summary: Used to edit the summary.

l Check Integrity [For All Events, For Selected Events]: Used to check integrity for all events
or selected events.

l Add Drop Rule: Used to add a drop rule.

l Create Alert Rule: Used to create an alert rule.

l Find Related: Used to find related query.

Historical Alert Processor

Users can select historical logs to correlate/create alerts with newly added rules. This feature
provides the ability to re-process certain database activities based on newly added rules.
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Breakdowns

Breakdowns panel is used to access breakdown event easily on a categorized list.
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Existing Assets

Queries

The queries used for the search criteria are listed here. When desired, query results can be accessed
by clicking on the relevant query.

Reports

The available query results are reported. It is possible to schedule to receive these reports regularly.

Schedule Properties

Users can select options and fill areas specific to their needs.

NOTE:When sending scheduled reports via email,
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l Data used to generate reports is classified based on the classification feature associated
with the role assigned to the recipients. This ensures that users only receive reports related
to documents they are authorized to access.

l In case of an error the relevant log entry can be displayed in the SystemMessages section
of the home page.
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DAM Query Examples

String Queries

PURPOSE QUERY

To search log entries starts with given
character or word:

a* companyname*

To search log entries ends with given
character or word:

*a *companyname

To search log entries that contain the
given keyword:

Companyname

To search for log entries using a
wildcard character to represent a
portion of the keyword:

companyn?me

To search for a keyword with corrected
spelling by allowing up to 2 characters
of error:

cmpnyname~

To search for log entries that contain
the keyword " companyname" and
either "productname" or
"applicationname":

companyname AND (productname OR
applicationname) Alternatively, you can use the OR
operator directly without parentheses: companyname
productname OR companyname applicationname

These queries will retrieve log entries that meet the specified conditions. The "AND" operator
ensures that the keyword "companyname" must be present in the log entries, while the "OR"
operator provides flexibility by allowing either " productname" or " applicationname" to be present.

Specific Field-Based Queries

PURPOSE QUERY

To search a full text: MachineName: ”Companyname-
PC” MachineName:
’Companyname-PC’ MachineName:
Companyname-PC

To search log entries starts with given character or word: MachineName: Companyname*
MachineName: a* c.

To search log entries ends with given character or word: MachineName: *companyname b.
MachineName: *a

To search for words with missing initial character(s), you
can use the following examples:

MachineName: *companyname
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To perform searches with restrictions on different fields,
you can use the following syntax:

Keywords: (critical OR error) AND
EventSource: ‘productname’
EventSource: ‘productname’ AND
(Keywords: 'critical' OR Keywords:
'error')

To search for a word with potential spelling mistakes and
allow for a certain degree of error tolerance, you can use
fuzzy search or approximate matching. In DAM, user can
utilize the tilde (~) operator to perform fuzzy searches.

EventSource: producnme~ (Correct
spelling is productname)
EventSource: productme~
EventSource: proutname~
EventSource: prouctnae~

To perform searches with restrictions on a single field: EventSource: ‘productname OR
OSname’ EventSource:
‘productname OSname’ (Works in
the same way with OR)

To perform a search using a specified range: TimeCreated: ’[Date to Date]’
TimeCreated: [* TO 2017-12-01]
(Returns all dates before the
specified date)

Search with sorting EventID: >10

EventID: >=10

EventID: >= 500 AND

EventID: <=1000

EventID: [500 TO 1000]

Regular Expression Queries

Regexp String Queries

PURPOSE QUERY

To search for a constraint between two
characters or words within a keyword, you can
use regular expressions. Regular expressions
allow for pattern matching and can help you
specify constraints in your search query. Here
are the examples you provided:

/(P|p)ro(ductname|file)/

This regular expression pattern will match the
word "Pro" followed by either "ductname" or
"file". The "(P|p)" part allows for variations in
the capitalization of the letter "P"

/(p|P)ro./

This regular expression pattern will match any
word that starts with "pro" or "Pro" followed by
any characters. The "(p|P)" part allows for
variations in the capitalization of the letter "P",
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and the "." represents any number of
characters after "pro" or "Pro”

To search log entries start with a given character
or word:

/a.*/

/companyname.*/

To search log entries ends with a given
character or word:

/.*a/

/.*companyname /

To search for a keyword using wildcard
characters, you can use the following symbols:

/compa.../

To search for numerical ranges, you can use the
following syntax:

/companyname/

/192.168.1./

To search for minimum or maximum repeating
words

/a{2,4}/

/a{3}a{2}/

/companyname{3}/

To search for minimum or maximum
occurrences of a keyword, you can use the
following examples:

/c~e/ Words starting with 'c' and ending with 'e'

/co~e/ Words starting with 'c', followed by 'o',
and ending with 'e'

Regexp Queries on Specific Fields

PURPOSE QUERY

To search for a keyword with a limitation
between two letters or words, you can use the
following example:

EventSource: /(P|p)ro(ductname|file)/ /(p|P)ro.*/

To search for records that start with a specific
character or word, you can use the following
examples:

MachineName: /a.*/

MachineName: /companyname.*/

To search for records that start with a specific
character or word, you can use the following
examples:

MachineName: /.*a/

MachineName: /.*companyname/

To search for any character occurring within a
word, you can use wildcard characters. The
most commonly used wildcard characters
are:

EventSource: /Produ../

To search for numerical ranges, you can
query for numbers within a specific range.
You can u use the following examples to
specify a range:

EventID: // MachineName: /companyname/
(MachineName: /.*companyname/ -

The reason for this is the ability to perform term-
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based searches without requiring any specific
word or character except for the one following the
asterisk.

To search for a specific number of characters
within a word, you can use the following
wildcard characters:

MachineName: /[a-z]{2,4}/

To search for a range of values within a
specific field:

MachineName: /p~e/

Words starting with 'p' and ending with 'e'

MachineName: /pr~e/

Words starting with 'p', followed by 'r', and ending
with 'e'

Alerts

l Severity shows the event type.

l State shows the action status of the event.

l Alert Time shows the date and time of the event occurrence.

l Computer Name shows the machine name where the event occurred.

l Name shows the event description.

l Suppress Count shows the number of suppressed events.

l Message shows the description.

NOTE: Users can specify a time frame that blocks thousands of alerts and actions by suppressing
them, improving system manageability.

When users right-click on the listed alarm records, users see following menus:
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Change Resolution State Menu:

l All: Allows you to change the resolution state for all records.
o New: Indicates a newly received alarm.
o Acknowledged: Indicates that the alarm has been reviewed and acknowledged by the

authorized person.
o Assigned to Helpdesk: Indicates the assignment of the alarm to the helpdesk team.
o Outsourced: Indicates the outsourcing of the alarm to external service providers.
o Resolved: Indicates that action has been taken regarding the alarm and it has been

resolved.

l Alert:
o Selected: Allows you to change the alert state only for the selected records.
o Go to Related Alert: Provides information about the alarm rule under which the record was

generated.
o Disable: Allows you to disable the alarm rule according to your preference.

Dashboard
Dashboard menu is used to visually monitor critical events that are important for organization without
the need for any specific reports. It allows users to create a customized dashboard with graphical
representations of the events.
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Sliding Dashboard Panel

To open the sliding panel and view all dashboard designs, click on arrow.
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In the sliding panel, users can select their favourite dashboard designs and take them to the top by
clicking icon.

When users want to delete one of the dashboard designs, they can click on the icon.

If users want to find the dashboard design they want by typing its name instead of scrolling, they can
use the Filter here.
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Controls Function

Edit Used to edit the dashboard.

Full Screen Used to display the dashboard full screen.

Refresh Used to refresh the dashboard.

Share Used to share the dashboard with internal users.

Actions Used to reach various actions related to the dashboard. Includes
Edit, Delete, Bookmark, Rename, New Dashboard [Blank
Dashboard, Copy From Existing], Import and Export.

Edit Dashboard

When the Editmode is enabled, 4 new tabs appear at the top as File, Design, Themes and
Options.

The File tab is used for Save, Delete, Rename and Bookmark operations.

The Design tab is used for Format Painter, Insert Widgets (Value, Pie, Bar, Column, Timeline,
Treemap,Map, Data Gird, Text, Image), Align, Undo and Redo operations.
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The Themes tab offers various Theme Designs. It also provides separate customization
opportunities for Background,Widget Caption,Widget Area,Widget Border and Chart
Formatting.

TheOptions tab allows user to change the Refresh Interval value.

After the editing process is completed, the user saves the changes using the Save button on the top
left. If users want to close the changes without saving, they use the Cancel button.
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Actions

l Edit: Used to edit the dashboard.

l Delete: Used to delete the dashboard.

l Bookmark: Used to take the dashboard to the top in the sliding dashboard panel. Its function is
the same as to star in a sliding dashboard panel.

l Rename: Used to rename the dashboard.

l New Dashboard [Blank Dashboard, Copy From Existing]: Used to add new dashboard
from blank one or copy from existing.

l Import: Used to import a design template that previously exported from another machine using
the saved file.

l Export: Used to export the dashboard design.

Creating a New Dashboard

Users can create a new dashboard according to their needs and track all activities through charts in
real time.

To create a new dashboard,

1. Click Actions > New Dashboard > Blank Dashboard.

2. In the New Dashboard window, enter the Dashboard name and description.
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3. Choose a theme for the new dashboard and press theOK button.

Agents
Agents Menu allows you to manage, monitor, and configure your agents. It consists of panels where
users can define and modify settings for the agents installed on client machines With Agents,
Policies, andOptions tabs.

l Add, delete, and edit agents through this interface.

l Modify agent policies and update certificates.

l Oversee a detailed monitoring process and read agent metrics with the Real-time Diagnostics
tool.

l Instantly intervene when the status of online agents changes.

l Observe agent updates and access information about machines.
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l Group your agents for monitoring purposes with the categorization feature.

l

Adding a New Agent

1. To add a new agent, click on New Agent button.

2. In the opened New Agents Wizard window, enter the IP Address of the machine where the
agent is installed, and choose the appropriate Protocol. If necessary, you can use the sub-
panel to upload certificates.

3. Click Next.
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4. In Listener Settings window, select which databases to collect logs from.

5. If needed, choose and modify additional settings such as time, port, trace, network, size,
memory, SSL, and more.

User Guide
DAM Usage

OpenText™ Database Activity Monitoring (24.4.0) Page 36 of 66



6. msg.file.max_age value is 10 as default, set this value to 1.

7. Click Next.
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8. In Policy Settings window, set the agent policy according to your drop rules or perform your
operations with the default policy.

9. Click Next.
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10. Check the collector settings.

11. If everything is OK, click Finish.

When clicked on Finish button, agent is created.
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Agents Tab
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Controls Function

DETAILS Used to reach details of the selected agent. Real-time Diagnostics tool available
here allows user to view the agent's activities and performance in real-time.

Refresh Used to refresh the agents tab.

New Agent Used to add new agent. For more details, see Adding a New Agent.

Edit Used to edit the selected agent.

Delete Used to delete the selected agent.

Actions Used to reach various actions related to the agents. Includes Export and Send as
Email.

Open
Terminal

Used to open terminal.

Policies

Controls Functions

Refresh Used to refresh the policy tab.

New Policy Used to add new policy.

Edit Used to edit the selected policy.

Delete Used to delete the selected policy.
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New Policy

To create a new policy, click the New Policy button on Agents-Policy tab and follow the steps given
below.

1. Enter the Policy Name.

2. Select Database.

3. Add a Description if necessary.

4. Add Rules. It can be tested with the Test Rule option.

5. Click the Save button to save the created policy.
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Options

The default certificate details can be changed via the Options tab. The upper part of the screen is
used for agents older than version 3.2.0.4084, and the lower part of the screen is used for agents of
version 3.2.0.4084 and higher.

Alert Rules

Controls Function

New Category Used to add new category about alert rules.

Refresh Used to refresh alert rules.

New Used to add new alert rule.

Edit Used to edit the alert rule.

Delete Used to delete the alert rule.
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Column Details

l Enabled shows the enabled or disabled status.

l Severity shows the type of the alert.

l Name shows the alert name/description.

l Update Date shows the date and time of the alert.

l Contains in Keyword shows whether it contains the specific keyword or not.

Adding New Alert Rule

To add a new alert rule, click the New button on Alert Rulesmenu and follow the steps given below.

1. Enter the Pattern Name in the opened Pattern Editor.

2. Select the Severity and Category options.

3. Select and fill the other pattern options related with time, matching and parameters if
necessary.

4. Click Add Rule button and select the Alert Rule Type [Generic Rule, Missed Rule, Multi-hit
Rule].

5. Follow the steps for selected Alert Rule Type.

6. Click theOK button to add the created alert rule.

Generic Rule

Generic Rule type is used to respond to a single event. User must enter the Name, Criteria,
Correlation Key, and Description fields to add a generic alert rule in Rule Editor window. Users
can see Criteria Helper by clicking ? icon.
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Missed Rule

Missed Rule type is used to respond to an event that does not happen within given interval. User
must enter the Name, Criteria, Correlation Key, Description, From, To and Interval fields to add a
missed alert rule in Rule Editor window.
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Multi-hit Rule

Multi-hit Rule type is used to respond to an event that will occur more than N times within given
interval. User must enter the Name, Criteria, Correlation Key, Description,Group By Key,
Interval, andMatch Condition fields to add a multi-hit alert rule in Rule Editor window.
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Mappings

Controls Function

New Category Used to add new category about mappings.

Refresh Used to refresh mappings.

New Used to add new mapping.

Edit Used to edit the mapping.

Delete Used to delete the mapping.

Column Details

l Enabled shows the enabled or disabled status.

l Name shows the mapping name.

l Description shows the mapping description.

l Event Source shows the event source about mappings.

l Event ID shows the event ID about mappings.

l Event Type shows the event type about mappings.

Add New Mappings

To add a new mapping, click New from theMappingmenu.
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1. EnterMapping Name.

2. Enter Description.

3. Fill in the Criteria, Events Source and Event Type sections.

4. Complete the Input, Code andOutput sections as appropriate.

Lookup Lists
Lists that are used to modify the outputs of goals and are specifically tailored to the situation. These
lists customize the outputs of goals, thereby increasing the accuracy of the outputs.

Purpose of use

l Adding lists to queries and reports on the search page.

l Adding lists to the alarm rules.

l Adding lists to Dataskope policies.

l Adding lists specific to the database.

l Adding lists specific to LDAP.

List Types

l Static List: Used to add lists to Search queries, Search reports, and Alarm rules.

l Dataskope List: Used to add lists to Dataskope policies.

l Database List: Used to customize database outputs.

l LDAP List: Used to customize LDAP outputs.
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Clicking the Save button after each change to the list disables the automatic submission process,
giving users the option to submit their modifications directly.

To activate this new change, click the Commit.

NOTE: Lookup list items can be easily moved to their relevant categories, enabling users to
efficiently and quickly reorganize items within the category structure, making list management
more flexible.
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Settings

Ref. Controls Function

Users Used to create, update,
and delete users.

User
Activities

Used to view user
activities.

Roles Used to create, update,
and delete roles.

API Users Used to create, update,
and delete API Users.

Security Used to change security
settings.

Notification
Groups

Used to create, update,
and delete notification
groups.

Storage Used to change database
settings.

System
Notification

Used to create and delete
system notification users.

SMTP
Server

Used to change SMTP
server settings.
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LDAP Server Used to change LDAP
server settings.

Action
Account

Used to reach account
information by DAM
agents.

Alert
Forwarding

Used to change alert
forwarding settings.

Distributed
Platform

Used to create, update,
and delete distributed
platform settings.

Multi-Tenant
Mapping

Used to create, update,
and delete multi-tenant
mappings.

VDAM
Maping

Used to create, update
and delete
VDAM Mappings

OpenVAS
Account

Used to OpenVAS API
connection management.

File Servers Used to create or delete
file server.

All Settings Used to create, update,
and delete DAM registry
settings.

User Settings

This setting is used to show the existing users and allows to perform editing, deletion, and addition
operations.
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Adding New User

Click New to add a new user and update the login information.

User Activities Settings

This setting is used to show user activities and allows to export the actions of permitted users in
JSON format within specific date ranges.
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Roles Settings

This setting is used to separate roles on the system according to their permissions. Users can add
new roles, edit existing roles, or delete roles.

Adding a New Role

This is used to customize the access scope as desired when adding a new role.

To add a New role, click New button on the Roles Settings.
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1. Enter the Role Name.

2. Enter the Description.

3. Check Assign to new users as default if necessary.

4. In UI ACCESS, turnOn the actions that users of this role want to be authorized for.

5. In UI ACCESS MEMBERS, select the users you want to have in this role.

6. In API Access tab, configure permissions for accessing public endpoints.
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7. In API Access Members tab, select the API Users assigned to that role.

8. In CLASSIFICATION CRITERIA, check Activate Classification if necessary.

9. Select Field Queries or Raw Query String and complete the relevant details.
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API Users Settings

This setting is used to define, delete, and edit API users.

Adding a New API User

1. Enter Name, User Name and Password fields.

2. For active users, click on the Active checkbox.

3. For expired users, click on Expires on checkbox and select the date.
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NOTE:

l Access to API users using public endpoints is granted based on assigned roles.

l Users attempting to access endpoints they are not authorized to are notified accordingly.

l Furthermore, data queried through endpoints is filtered based on the classification
defined in the user's role, ensuring that only authorized records are displayed.

Security Settings

This setting is used to perform users’ current password settings and they can also set the duration for
periodic password changes.

Notification Group Settings

This setting is used to determine the groups to which notifications will be sent.
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Adding a New Notification Group

1. EnterGroup Name, Description, and Email fields.

2. Click on Users who will be included in the group.

Storage Settings

Main Storage Settings

This setting and its submenus are used to modify detailed storage settings related to Elasticsearch.
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Storage Security Settings

This setting is used to set password for secure access to Elasticsearch.

Import Archive Settings

This setting is used to restore users’ old indexes from their archive.

Restore from Backup

This setting is for viewing and restoring users’ backed-up indexes.
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Storage Curator Settings

This setting can be used the necessary settings for the curator operation performed on Elasticsearch
on a daily basis.

System Notification Settings

This setting can be used to receive important system notifications in the form of an end-of-day report.
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SMTP Server Settings

This setting can be utilized to configure mail service settings.

LDAP Server Settings

The server information related to users’ LDAP service can be entered on this screen.
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Action Account Settings

Domain Name, User Name and Password details of the action account can be entered on this
screen.

Alert Forwarding Settings

This setting can be used to redirect alarms to another domain.
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Distributed Search Settings

This setting can be used to connect independent Elasticsearch instances together and perform
searches from a single interface.

Multi-Tenant Mapping Settings

Code can be written as a mapping to perform normalization, enrichment, and taxonomy on events.
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DAM Mapping

DAMMapping enables the enrichment of logs at the DAM Collector stage.

OpenVAS Account Settings

To connect an OpenVAS account, credentials should be entered.

File Server Settings

This setting can be used to define a new file server.
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Figure 1: File Server Settings

Figure 2:

All Settings

Accessing and modifying all settings on this screen is possible.
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